
Tutorial for OCAD 7 and PICOVER
How to plan a Colour-coded  Event using OCAD 7 and PICOVER MKII

These instructions assume that you have been sent CD’s of the software and an OCAD file of the map for
your event by e-mail or floppy disc or CD.  As with most computer programs there are several ways of doing
anything. This way seems to work quite well. In the following, the symbol ’ > ’ means ‘select’ or ‘click on’.

1 Install the OCAD program from the CD.

This is self installing. Follow the instructions on the Screen.

2 Install the PICOVER program from the CD.

Insert the CD and using Windows Explorer inspect the contents:
Files Currently on CD:
Folder – Example Files, Folder – Picover MKII (1); Folder Picover MKII (1a); Folder Picover MKII (4)
> Picover MKII (1) > DISK 1>SETUP.EXE.  Then follow the instructions on the Screen.

3 Open the OCAD program.

Click on the OCAD icon on your desktop. Open the base map. > File; > Open: Browse to find the
OCAD map file, say ‘corecopse.ocd’; > Open  The map should appear.

> Options; > Scales. This will tell you the scale of the map. This may not be the scale that appears
on the front of the map! Do not change the scale of the map!
Many maps are made at 1:15000 scale so that all the symbol sizes are correct. The map may be
printed at 1:10000 in which case all symbols, line widths, texts, etc. are blown up by a factor of 1.5
Knowing the scale of the map is important when starting an event in PICOVER.

4 Save the base map with another file name.  Use this map to familiarise yourself with OCAD 7.

> Save as; Insert a different file name eg ‘test’; .> Save.  Now you can play around with the map
leaving the original map unchanged.  Look at the various viewing options: > View.
Click on a drawing tool from the six in the top right hand corner of the screen (curve; ellipse; circle;
rectangle; straight line; freehand). Click on any line symbol from the ‘tool box’ on the right hand side
of the screen. Draw something! Draw lots of things with the various tools. Draw areas by selecting
an area symbol and draw the required shape with one of the drawing tools.

Click on one of the ‘pick’ tools (a black arrowhead or a white arrow head). The white arrowhead can
be used to move points individually. The black arrowhead can be used to move  lines, areas and
groups of objects as a whole without distortion.

> White Arrowhead; select a line on the map; > Scissors symbol. Select a point in the line and click
on it. A new point appears. Select a segment of the line and > Delete. The piece of line is removed.

Try writing text with the straight line drawing tool after selecting a text symbol from the tool box.
Try selecting a block of text and moving around the map with one of the ‘arrowhead’ tools.
Try selecting a symbol from the toolbox; > symbol; > edit.  You will see that you can change almost
anything!
> New > Load symbols from ISO200SYMBOLS15000.ocd
Try drawing a fictitious map. Then save it with a different name or close without saving it. Use the
‘help’ if necessary.

5 Print off several copies of the base map.

> File > Print (You get the 'general' page of the print dialogue box.)>Properties. Set your printer to
A4 Portrait Best Quality printing ,then > OK
From the 'general' page of the print dialogue box,  Set print Scale to 10000. > Window > To page
Size > Define Window. You will then get the map with a rectangular frame around it). Move the



frame so that it encompasses the entire map.  > File > Print (You get the 'general' page of the print
dialogue box.) > Print.

6 Start planning the event

Roughly plan the courses at home. Visit the event area. Tag sites. Note any changes and map
corrections you need  to make to the base map. Draw on your proposed control sites and courses
on a blank map(s).

7 Open PICOVER.

Click on the PICOVER Icon on your desktop. A Blue Start-up Screen appears. > New Event.
Type of Event > radio button for ‘single scale’ > OK.
Enter three character prefix, say, ‘CPS’ ; > OK.
Enter event title. Eg DEVON LEAGUE EVENT 10 AUG 06 or similar; > OK.
Enter event closing time: eg 1500; > OK.
If the map scale is correct; > OK otherwise change the map scale and > OK.

8 Select blank map

Select the base map to make the all-controls map. Browse to find the map file. > OK
A Blue title page appears with the event title across the middle.

9 Put controls on the all-controls map.

At the blue screen > Planning; > Edit Controls (no course)  The map appears.
 Using symbol: purple control point number (602.1), write the words ‘Title’; ‘Course’; ‘Class’; and the
number ‘0’ on the map in some blank space around the edge of the map but inside the border. It



doesn’t really matter where you put these words. The ‘0’ tells the program what size to make the text
and will not generate any overprints without it.

From the Symbol set on the right hand side of the screen, select the purple ‘5’ symbol. > Symbol; >
Edit. Change the Character height to 4 mm (for a map which is 1:15000 – See 3 above).

From the Symbol set on the right hand side of the screen, select the purple ‘Z’ symbol. > Symbol; >
Edit. Change the Character height to 4 mm (for a map which is 1:15000 – See 3 above).

From the Symbol set on the right hand side of the screen, select purple circle symbol (602.0).
> straight line drawing mode (2

nd
 from right).  Click cursor on where you want the Start to be. A circle

appears. Click cursor on where the Finish will be. Another circle appears. Similarly draw in all the
control points.
> File; >Save; > File; > Close; > File; > Exit.  Blue title page appears.
> Planning; > Edit Controls (no course)  The map appears again but this time it has all the circles
each with a three letter code.

10 Change the default codes to the control codes you will be using.

Click on White Arrowhead. Select a three letter code. Click at the front end of the three letter code –
cursor changes to a vertical line. Write in the code number to be used for the site and delete the
three letters. Repeat this with all the circles including the Start and Finish. I usually use 100 for the
Start and 999 for the Finish. When done > File; > Save; > File; > Close; > File; > Exit. Blue title page
appears. You can also ‘save’ as you go along and re-enter the all-controls map and continue
changing all the codes.

.
11 Input the first course data.

At the blue screen > Inputs: > Course Data; > New Course.
New Course name: Enter one of BR, BL, GN, LG, OR, YE, WH as appropriate.
Class: Enter one of BROWN, BLUE, GREEN, LIGHT GREEN, ORANGE, YELLOW, WHITE as
appropriate.
> New Line; > Edit Course Line ‘S’; Data > 100. > New Line; > Edit Course Line ‘C1’ Data > control
code for 1

st
 control.; > New Line; > Edit Course Line ‘C2’ > control code for 2

nd
 control  and so on.

You can speed this up by pressing ‘enter’ after each control code has been entered. At the end of
the course > New Line; > Edit Course Line ‘F’ Data > control code for final control.
After this: > New Line; > Edit Course Line ‘D1 or D2 or D3’; Data > distance in metres from final
control to the Finish.
D1 – Follow marked route to Finish xxx metres.
D2 – Navigate to Finish Funnel, Follow tapes xxx metres to Finish.
D3 – navigate xxx metres to Finish.
> Save; > Exit.

If you want to insert extra lines of text in the course descriptions, at the blue screen: > Inputs; >
Event Data.
Write in: D19: ‘use marked crossing point’  D20: ‘take care crossing the road’ etc  Insert these at the
appropriate point in the course in the Course Data Entry box. Edit Course Line : D19;  Data > leave
blank.

12 Generate the course overprint

At the blue title screen > Outputs; > Overprints; > Generate Course Overprint(s).
Enter under ‘Courses’ the course number eg BR, BL etc. > Generate. Look at overprint map. Does it
look right?. > Save; > Exit

13 Check the course length

At the blue title screen > Facilities; > Summary of all input data; > OK.
Inspect the data to find the length of the course.



14 Repeat 11, 12 and 13 for each course.

15 Inspect the courses on top of the blank map.

At the blue title screen > Outputs; > Overprints; > Edit a Course on a Blank Map.
Enter under ‘Existing output’ the course number eg BR, BL etc. > Generate. Look at overprint on top
of the map. Is this what you intended? > Save; > Exit.

16 Enter Control Descriptions so that Course Descriptions can be produced.

At the blue screen >Inputs; > Tag Site Data. You will find a list of all the controls that you have
drawn on the all-controls map.
Click on a code number; > click Pic; > pictogram for box ‘C’: > box ‘C’ similarly for boxes D,E,F,G
and H; > OK.
Pick another control code number and repeat until all controls have been done. > Save and Exit.
Back to blue screen.

17 Generate Course descriptions

At the blue screen > Outputs; > Pictorial Descriptions. Under ‘Courses’ enter the course number. >
Generate. Does this look right? > File; > Save; > Exit.
At the blue screen > Outputs; > Text Descriptions. Under ‘Courses’ enter the course number. >
Generate. Does this look right? > File; > Save; > Exit.

18 Produce an All-controls map for setting out/checking tags the controls in the field.

At the blue screen > Facilities; > Map of Control Site data; > T (for tag) > return. This produces a
map of the control circles and codes called ‘tag names’ with the date shown.
> File: > Import. Select the base map:  The file name will look like ‘CPS1A.OCD’; > Open: > (Click
radio button) Place with offset: Horizontal 0.00mm, Vertical 0.00 mm. The base map will appear
beneath the control codes and numbers. > File: > Save as: Use a new file name, say ‘allsites.ocd’
This map can now be edited and the control codes moved around for clarity. > File; > Save; > File: >
Close; > File; > Exit.

19 Produce a list of all the Pictorial descriptions

At the blue screen > Facilities: > Display All Controls Pictorial List: > Enter or 1 or 2 or 3; > T (for tag
order): return.
This can be printed and used with the ‘allsites.ocd’ map.

20 You now have all the data entered into PICOVER.

You can now change anything you like. On the all-controls map, you can add controls, delete
controls, move controls. On the courses you can also add and delete controls, not forgetting to re-
number them. You can change control descriptions. Re-generate the overprints and course
descriptions. When you are satisfied, edit the courses on the blank map (15 above) Move the
numbers around so as to make them more readable and less confusing. > File; > Save; ( to preserve
the changes you have made on the overprint) then > Save as: ‘brownmap.ocd’ or similar new file
name, then > Exit. Repeat for each course. You now have 6 or 7 maps, one for each course, which
you can print and send to the Controller.

When the Controller has had his say, you will probably want to do more changes. Make all the
required changes and regenerate the course overprints and regenerate the course descriptions.

When satisfied, using the ‘Edit a Course on a Blank Map’ facility, edit the control circles, control
number positions and connecting lines. > Save (to save the purple overprint map) and > Save as, for
a complete map, say brownmap’etc.



21 Correct the base map.

You may wish to make alterations to the base map. Save it with a new file name say ‘corecopse rev
07-11-06’

22 Changing the Base map

You can change the base map at any time in PICOVER.
At the blue screen: > Planning; > Substitute Blank Map. Browse to find latest base map file; > Open;
Backup Files in Main OVR/HYT Folder Now?; > No: > Q for quit; > Q for quit; Not a Dual Scale
Event; > OK .

At the blue screen: > Planning; > Edit Controls (No Course) The map should now be the new map.

23 Final maps for printing

As described in the latter part of 20 above, use the ‘Edit a Course on a Blank Map’ facility and save
as 6 or 7 new maps, say brownmap’ etc.  To print maps, see section 5 above

Or:

24 Final maps for printing

In OCAD 7, merge the course overprints with the latest base map using the ‘import’ facility.
ie. In OCAD 7, Open ‘Corecopse rev 07-11-06’ > File; > Import. Select the overprint file > Open: >
(Click radio button) Place with offset: Horizontal 0.00mm, Vertical 0.00 mm. The new map is now
merged with the overprint and can be saved as, say, ‘newbrownmap.ocd’ or similar. Repeat for all
the courses. To print maps, see section 5 above.

25 Height calculation

This is best ignored for a 6 or 7 course event. It is tedious and only worthwhile for a 20 course
Regional Event. Height calculation is best done by hand and inserted into the course descriptions.

26 File Structure:  These files are accessible from outside PICOVER in OCAD 7.

In:  My Computer / Local Disk C / Program Files / Ocad7 /  CPS1A>

 OVR> OBR Brown course overprint You could store your completed course maps
OBL Blue course overprint here eg ‘brownmap.ocd’ and
OGN Green course overprint ‘newbrownmap.ocd’ etc.
OLG Light Green course overprint
OOR Orange course overprint
OYE Yellow course overprint
OWH White course overprint

PIC> PBR IOF Pictorial for brown course By using the import facility  you can merge
PBL IOF Pictorial for blue course these together to make an ‘allpics.ocd’ file
PGN IOF Pictorial for green course or four copies of a course description on
PLG IOF Pictorial for light green course one sheet. Say ‘PBRx4.ocd’ for printing
POR not usually required loose Course Descriptions.
PYE not usually required
PWH not usually required

TED> TBR.TXT not usually required The text files can be imported into MS Word
TBL.TXT not usually required and saved as Word (.doc) files and edited to
TGN.TXT not usually required produce passable versions in English. Usually
TLG.TXT Text description for Light Green course four courses can be fitted on to one A4 sheet
TOR.TXT Text description for Orange course for printing loose Course Descriptions.
TYE.TXT Text description for Yellow course
TWH.TXT Text description for White course



CPS1A.OCD This is the base map
CPSIAALL.CON Inaccessible
CPSIAALL.OCD This is the All-controls map
CPS1AALL.TAG Inaccessible
CPSIACOD.OCD This is the All pictorial descriptions list
CPS1APUB.OCD This is the purple background map
CPS1ATAG.OCD This is the map of all the control codes

There are lots of other facilities which you can find for yourself by clicking on the options displayed at the top
of the blue screen. Feel free to experiment but be careful to save your work as you go along.
Any queries can be sent to me at : roger-green@blueyonder.co.uk  or tel: 01392 278512            Roger Green


